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ABSTRACT
Design and Verification of a LabVIEW Automated Antenna Radiation Pattern
Measurement System
Dylan Curtis Bloom

In 2014, Toyon Research Corporation donated a 6’x6’x8’ anechoic chamber to
the Cal Poly EE department to advance student education in the areas of antennas and
wireless communications. An anechoic chamber is a room designed to suppress
electromagnetic radiation reflections so that accurate measurement of radio frequency
(RF) systems such as wireless radios and antennas can take place. Despite the fact that
Cal Poly already has a larger anechoic chamber, primarily used for antenna
characterization, it is the purpose of this project to design, code, and equip the new
chamber so that it performs at least as good, or better than, the existing chamber.
Radiation pattern is a key characteristic that describes the directionality or gain of
an antenna, and it is important for quantifying and qualifying how an antenna will perform
as part of a wireless communication system. Radiation pattern measurement can be
time consuming because it requires measuring an antenna’s transmission or reception in
in all directions. In both the old and new antenna measurement systems (AMS), a vector
network analyzer (VNA) measures signals transmitted between the antenna under test
(AUT) and an RF field probe within the antireflective environment of the anechoic
chamber. The new system synchronizes VNA measurement with the rotation of the AUT
using the automation software LabVIEW and a Sunol Sciences FS-121 antenna
positioner. Then, Matlab plots the data collected by LabVIEW as well as calculates
useful antenna metrics including half power beam width (HPBW) and directivity.
LabVIEW also makes the AMS easy to operate because of its graphical user interface.
iv

The new anechoic chamber completes measurements faster than Cal Poly’s
existing chamber, with good accuracy and ease of use. The new chamber works best
with smaller antennas at frequencies up to 6 GHz and beyond. Radiation patterns have
good SNR, and match with simulations and measurements done in the larger chamber.
However, due to its smaller size the new AMS is not a replacement for the existing larger
system when testing antennas larger than 1 m or at frequencies below 2 GHz.
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CHAPTER 1: Introduction

1.1 Why Test Antennas?
All wireless systems rely on antennas to transmit and receive electromagnetic
messages. Depending on the communication system – GPS, Wi-Fi, or point-to-point
data links – antennas are used to optimize message transmission for multiple systems. It
is important to test antennas to verify system-required performance standards including
gain and directivity. Gain and directivity are defined along with other antenna
fundamentals in section 1.3.
Characteristics of antenna performance include radiation pattern, resonant
frequency, and sensitivity as part of a system. Measurements must be conducted in an
isolated, noise-free environment. Electromagnetic noise prohibits accurate antenna
measurement and is attenuated by an anechoic chamber discussed in the following
section.
Antenna testing involves repetitive measurements while rotating the antenna
under test (AUT) in all directions, and this lends itself to automation. Measuring the gain
of an antenna in a single dimension is simple to do manually, but to manually measure
its gain in a 360º spherical plane at 1º intervals becomes time consuming and difficult to
perform accurately. Automating the measurement therefore improves the design process
by decreasing test duration and improving the quality of results. Furthermore,
automation improves test repeatability and eliminates many possibilities for human error.
The results presented in this paper contribute to the sphere of antenna
measurement by providing new insight into the benefits and drawbacks of using smaller
anechoic chambers over larger ones.
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1.2 Why an Anechoic Chamber?
Antennas are tested in what are known as antenna ranges, and while various
types of ranges exist, each strive to create a similar ideal test environment. The two
most important environmental variables in antenna testing are noise and reflections.
Noise is undesirable electromagnetic interference that can come from various sources
both external and internal to the antenna system. Reflections deflect the test
environment surfaces and superimpose with the direct path signal.
Anechoic chambers are enclosed rooms lined with absorber material designed to
suppress reflections. While more expensive than outdoor ranges, anechoic chambers
offer isolation from the outside world and an enclosed and consistent test environment.
Outdoor ranges suffer exposure to ambient RF signals and weather limitations. Weather
is unpredictable, affects the characteristics (humidity and rain) between the transmit and
receive antennas, and can damage test equipment.

Figure 1 Pyramidal Horn Antenna in the Cal Poly Microwave Lab Anechoic Chamber
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The Cal Poly Microwave Lab anechoic chamber in Figure 1 uses pyramidal foam
blocks to absorb stray signals and suppress reflections. Pyramidal absorbers
progressively absorb energy through ohmic losses by steadily increasing the impedance
from free space at the surface of the absorber to high impedance lossy material.
In addition to testing antennas, anechoic chambers are commonly used for FCC
emissions and immunity testing on cell phones. The FCC sets guidelines for what power
and frequency signals devices can emit to not interfere with other wireless systems.
Immunity testing ensures that a system can operate normally where foreign RF sources
are present. The noise free environment is ideal for the scientific accuracy of these tests.

1.3 Antenna Fundamentals
The following section defines antenna radiation patterns, gain, polarization, and
common measurement methods. Section 1.3.5 defines near and far field regions and
how they affect anechoic chamber size and operating frequency range.
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1.3.1 Antenna Coordinate System
Engineers use the antenna spherical coordinate system in Figure 2 to define
antenna position and properties. Phi rotation about the z-axis is azimuth, and theta
rotation away from the z-axis is elevation. In an anechoic chamber, the x-axis is defined
with respect to the chamber and points from the antenna under test to the receive
antenna.

Figure 2 Antenna Spherical Coordinate System [2, 9]

1.3.2 Radiation Patterns
“An antenna [radiation] pattern is a graphical representation of the field
magnitude at a fixed distance from an antenna as a function of direction. With the
antenna at the origin of a spherical coordinate system, radiation fields E and H are
perpendicular to each other and both are transverse to the direction of propagation” [1].
Half-power beam width (HPBW), gain, directivity, and polarization are performance
factors derived from pattern measurements and are discussed in sections 1.3.3 and
1.3.4.
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The normalized field pattern is a polar plot of field magnitude normalized relative
to the maximum radiated E-field. The main beam is the direction the antenna
concentrates most of its radiation; side lobes are weaker radiation lobes in other
directions. HPBW is the angular span between the two half-power (-3 dB) points on
either side of the main beam.

Figure 3 Normalized Radiation Field Pattern and its Components [1]

Measured radiation patterns are often plotted in decibels. The logarithmic power
pattern is a polar plot of these values and relates to the absolute field pattern as follows.

Equation 1
where P(θ, φ) (dB) is the logarithmic power pattern and F(θ, φ) is the absolute field
pattern. Radiation patterns are typically plotted as logarithmic power patterns to show
more detail in the side lobes.

5

To measure radiation pattern, an RF probe is placed in the far field of the AUT.
While the AUT rotates through all its spherical angles, a constant signal is transmitted
from the antenna, and power levels received by the probe are recorded for each angle.
Alternatively, the AUT can remain stationary while the probe moves around the antenna
at a constant radius. The probe is a calibrated antenna connected to an RF power meter.
In addition to rotation, both the AUT and RF probe positioners include a roll axis to
enable polarization testing, see Figure 4. Polarization is described in section 1.3.4.

Figure 4 (a) Pattern Measurement Conceptualized (b) Model Positioner [2]

In practice, a vector network analyzer (VNA) can be the sole instrument in an
antenna measurement system. A VNA is used to measure two-port systems by sending
a signal into one port and measuring what is received at the other port. It can both
generate the signal transmitted by the AUT and measure the received signal by the RF
probe. It is also capable of performing a separate reflection measurement on the AUT
over a frequency range to determine what frequency the antenna transmits best. Any
power not transmitted by an antenna is reflected back to the RF generator, or VNA in this
case.
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In Figure 5 below, the black box represents a two-port system. The left side is
port 1 and the right side is port 2. The VNA also has two ports, each connected to one
side of the system. A VNA measures scattering parameters (S-parameters) of a system
through incident, reflected, and transmitted signals. Signal a1 is the component of the
signal generated by the VNA that enters the system and is incident on port 1, while
signal b1 is the component reflected by port 1. Signal b2 is the component transmitted
from port 1 to port 2 and received by the VNA, and signal a2 is the component
transmitted from port 1 to port 2 but reflected at the VNA. S11 is the ratio of the reflected
signal to incident signal at port 1, the reflection coefficient of port 1. S22 is identical to S11
but at port 2. S21 is the ratio of the signal transmitted to port 2 from port 1, the forward
gain. S12 is the opposite of S21 known as the reverse gain. The VNA sweeps outgoing
signals over a frequency range, and displays S-parameters as a function of frequency.

Figure 5 Illustration of S-parameters for a Two-Port System

For an antenna connected to port 1, S11 will be close to unity over the
frequencies which the antenna does not radiate well, and small over the frequencies
which do radiate. This AMS delivers a signal to the AUT on port 1, and the signal is sent
over the air to the known antenna on port 2. S21 is the forward gain of the antenna-probe
system, or the ratio of the signal sent to the AUT versus the signal received by the
known antenna. The loss through the cables connecting the AUT and probe to the VNA
7

is negligible, <1dB, because they are impedance matched to the VNA (50Ω). Therefore
S21 equal to the power sent to the AUT, minus the power reflected at the AUT input port,
minus the air loss between the AUT and the probe, and minus the power not picked up
by the probe. With an ideal RF probe, any power not picked up is power sent in other
directions by the AUT. The air loss between the AUT and the probe is a constant, and
can be accounted for by normalizing the S21 data. Thus, the radiation pattern for the AUT
is just S21 plotted over all spherical angles.

1.3.3 Directivity and Gain

Figure 6 Illustration of Directivity [1]
An antenna’s directivity (D) is the ratio of the radiation intensity in the main beam
direction (Um) to the average radiation intensity (Uave). Radiation intensity is the power
radiated in each direction per unit solid angle (steradian), and is independent of distance
(r). The total power (P) radiated by an antenna is the integral of the radiation intensity
over all solid angles around the antenna. The directivity calculation compares an
antenna’s radiation pattern to that of an ideal uniform (isotropic) source. An isotropic
source has uniform radiation intensity, but is unachievable in practice. Uave is the power
radiated in a single steradian if the antenna pattern were isotropic. Since only 4π
steradians are in a sphere, Uave is P divided by 4π. An isotropic source has the minimum
possible directivity of 1, and all real antennas have a directivity greater than 1.
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Equation 2
The gain of an antenna is the directivity multiplied by its radiation efficiency,
where radiation efficiency is the ratio of total power transmitted (P) to input power (Pin).
Many antennas are highly efficient with an efficiency close to one, so their directivity is a
good approximation of their gain. However electrically small antennas, where physical
dimensions are less than one half wavelength, are relatively inefficient and have
efficiencies much less than one [1].

Equation 3
Antennas with directivities close to unity, meaning they transmit more or less
equally in all directions, are commonly used in broadcast transmission and receiving so
that reception is not dependent on the direction each party is facing. Examples are
antennas used in cell phones and broadcast radio. High gain antennas, on the other
hand, are capable of transmitting over longer distances with the same applied input
power, are used in point-to-point communication systems. Another application of high
gain antennas is receiving the signal of broadcast antenna from a further distance
possible than with an isotropic receiver, provided that the direction of the source is
known. Using advanced techniques it is also possible to design an antenna with an
adjustable gain and main beam direction. This requires an array of antennas, where the
separation distance between them is known, and the same signal is sent to each
antenna but with a slightly different phase such that their mutual radiations add and
subtract in what is known as beam forming, or beam steering.
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1.3.4 Polarization
Electromagnetic radiation from an antenna is composed of coupled electric (E)
and magnetic (H) fields that oscillate in magnitude over time and space. As an
electromagnetic wave propagates, its E and H field vectors oscillate and rotate about the
direction of propagation in an unchanging pattern. This pattern, called wave polarization,
is a product of the shape of the antenna that generated them. Generally, antennas can
only receive signals that match their own polarization.
Figure 7 shows the dual field vectors of a linearly polarized wave propagating
along the z-axis at a fixed moment in time. Polarization can be described as the behavior
of only the E field vector as the wave propagates because the H field will always be
orthogonal. Because the electric field vector in Figure 7 only oscillates up and down as it
travels along the z-axis, and does not rotate, the wave is considered linearly polarized.
Because the electric field vector oscillates up and down the x-axis, and not side to side
with the y-axis, the wave is vertically polarized. Figure 7 also shows how the electric and
magnetic field vectors are orthogonal in the direction of propagation.

Figure 7 Spatial Behavior of Electric (solid) and Magnetic (dashed) Fields of a Linearly
(vertical) Polarized Wave for a Fixed Instant of Time [1]
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Typically, polarization is illustrated on an XY plot showing the behavior of just the
electric field vector along the axis of propagation. Figure 8 illustrates some wave
polarization states. Generally, waves have an elliptical polarization with an x and y
component and either a left-hand or right-hand sense of rotation. However, dipole and
monopole antennas are considered linearly polarized – a special case of elliptical
polarization.

Figure 8 Some Polarization States (the wave is approaching) [1]
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Another way to illustrate polarization is the Poincaré Sphere in Figure 9. The
Poincaré Sphere is a 3D plot where all possible polarizations lie somewhere on its
surface. Its equator represents all possible linear polarizations, its north pole represents
perfect right-hand circular polarization, and its south pole represents perfect left-hand
circular polarization. All other points on its surface represent the various elliptical
polarizations.

Figure 9 The Poincaré Sphere [1]

In the real world, antennas will emit multiple polarization types because they are
not ideal, nonetheless the dominant polarization type defines the overall polarization.
Antennas only receive signals that align with their polarization. This means a linear
vertical polarized (LVP) antenna can only pick up signals with a vertical component. This
includes elliptically polarized signals, where the ratio of vertical to horizontal components
is proportional to the signal strength received. A linearly polarized antenna can receive
circular polarized (CP) signals no matter its orientation. An example of the is GPS
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satellites which transmit CP signals so GPS receiving devices can pick up signals
regardless of their orientation.

1.3.5 The Near and Far Field

Figure 10 Summary of the Field Regions (not to scale) [1]

The near and far fields are regions surrounding a transmit antenna which
describe the radiative/non-radiative nature of the EM signals within them. Closest to the
antenna, reactive EM fields dominate in the reactive near field. These EM fields diminish
greatly as they move away from the source antenna, at a 1/r^3 rate, and are not suitable
for long distance communication. Outside of the near field, radiative EM fields dominate.
Radiative fields diminish much more gradually over greater distance from the source, at
a 1/r rate. The total radiative field energy passing through a surface at a distance r is
proportional to 1/r^2. Since the area of a sphere is proportional to r^2, the total energy
passing through a sphere of any radius r remains constant. This means that the far field
energy escapes to infinite distance, i.e. it radiates.
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The radiating region is divided into the radiative near field and the far field. Due
to the geometry of the antenna and the wavelength of the carrier frequency, waves in the
radiative near field can be out of phase and incoherent to receivers. It is not until the
waves pass the Fraunhofer distance that they are in the far field and an antenna can
reliably receive them. Beyond this distance, the wave is approximately planar. While it is
possible to design antennas for the near field, most antennas communicate in the far
field. The Fraunhofer distance is given by:

Equation 4
See Appendix A for the far field derivation.
The total far field energy passing through a surface at a distance r from the
source remains constant for any r. This means far field energy radiates to infinite
distance if nothing blocks or absorbs it along the way. The ratio of the power received
(Pr) by an antenna to the power sent from a transmit antenna (Pt) in the far field is given
by the Friis equation.
Equation 5

Gt and Gr are the gain of the transmit and receive antennas, R is the distance separating
the antennas, and λ is the wavelength of the signal. The Friis equation is valid for radii R
greater than the longer near field distance of either antenna. Because gain is about
equal to directivity, knowing and being able to measure directivity allows an RF system
engineer to calculate the power needed to transmit a signal over a given distance. This
is extremely important to RF system design and also the goal of this antenna
measurement system project.
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CHAPTER 2: Anechoic Chamber and Test Equipment

This chapter describes the physical design of the new anechoic chamber, as well
as the selection process for the antenna positioners and network analyzer.

2.1 The Microwave Lab Anechoic Chamber
The new anechoic chamber in the Cal Poly Microwave Lab measures 6’x6’x8’
and is made of an interlocking wood frame. 16” pyramidal foam absorbers line the
interior of the chamber except for a small opening at the bottom cut for the AUT mount.
There are removable access panels on the ends, top, and sides of the chamber. The
panels allow access to the AUT during mounting, provide a window for the receive
antenna to measure the AUT from, and allow viewing of the AUT during a test to ensure
the positioner is operating properly. Figure 11 shows a cross section of the chamber
during a typical radiation pattern measurement test.
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Figure 11 Cross Section of the Cal Poly Microwave Lab Anechoic Chamber (to scale)

Section 1.3.2 discussed two methods for antenna pattern measurement: rotating
the AUT, or rotating the RF probe about the AUT. The former method works well for small
scale setups like this one where the AUT/DUT is easy to rotate, while the latter method
requires more space and equipment to move the RF probe around the AUT. Because
this chamber is small, any antenna tested in it should be small and easy to rotate, also
the hole in the bottom is the perfect size for an antenna positioner. To support these
types of measurements the AMS has one programmable positioner and one manually
adjustable positioner to allow a variety of physical test setups while keeping costs low.
An RF test equipment manufacturer supplied the programmable positioner, while the
manual positioner was designed and built on site to complement it. The programmable
16

positioner can rotate the AUT over 360º azimuthal sweeps. More on the positioner in the
following sections. High frequency coaxial SMA cables link the VNA to the antennas,
while a PC running LabVIEW and Matlab controls the instruments and generates
reports.

2.2 Choosing an AUT Positioner
The important attributes of an antenna positioner include rotation type (azimuth,
elevation, skew), load capacity (power, torque, angular accuracy), computer
controllability, antenna mounting style, and total cost. Other considerations include
durability, lifespan, and quality of customer support. Factors for this specific project
include budget, size of the anechoic chamber, size of antennas under test, and the test
automation software. The original goal was to stay under $2,000 dollars.
It would be convenient to have more than one axis of rotation, but online
research indicated that an azimuth only positioner would be the most cost effective.
Azimuth is the main degree of freedom necessary for radiation pattern measurement,
and more degrees of freedom tend to cost more money. Also, with the proper mount in
an azimuthal positioner, the antenna can roll left or right manually to allow elevation
sweeps or varied polarization. Furthermore, the addition of a motorized roll axis would
add extra size and complexity. Because the motor produces noise and can interfere with
the signals inside the chamber, it requires a gear and belt drive to stay outside the
chamber.
The size of the anechoic chamber limits the size of the antennas that can fit
inside and therefore provides an upper limit on the reasonable amount of power and
torque necessary from the positioner motor. Chamber dimensions prohibit an antenna
larger than 1m3, as the antenna will need to fully rotate without touching the foam
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absorbers. The goal for max antenna weight is 50 lbs. These dimensions limit half
wavelength antennas to frequencies above 150 MHz.
LabVIEW works with a wide variety of standard interfaces including USB, GPIB,
and RS-232/Serial. Most commercial programmable instruments have LabVIEW drivers
available online on the National Instruments website. Sometimes, however, these drivers
do not exist and must be custom made. There is a tradeoff between cost and the ease of
use of pre-written drivers. On one hand, making use of a positioner with a pre-made
computer interface requires less work. On the other hand, it is inexpensive to write
drivers. Additionally, one can write custom drivers tailored to the project’s specific needs.
Finally, the positioner should be durable and last at least 10 to 20 years without
excessive repair or replacement. Students are clumsy and this positioner should be
sufficiently sturdy to withstand their mistakes. The product supplier should also be
sufficiently reliable to provide support and replacement parts for years to come. Table 1
below and on the following page compares six potential positioners with these
considerations in mind.
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Table 1 Potential Antenna Positioners and their Features
Company

Model

Torque/
Power/Load
Capability

Computer
Mast/Antenna
Connectivity Mount

Sunol
Sciences

ELAZ75
Elevation/
Azimuth
Antenna
Positioner
System

Manufacturer RS-232
did not
included
respond
No LabVIEW
drivers

Included

$15,000

Sunol
Sciences

FS-121 Free
Space
Turntable

EUT Load
Rating 10lb

Custom Mast
Available

<$3,000

Mast not
included

<$1,500

RS-232
included

Total
Cost

No LabVIEW
drivers, but
simple serial
commands
available
Yaesu

G-800DXA
Amateur
antenna
positioner
motor

20 sq. ft.
antennas
medium duty

RS-232
computer
interface sold
separately
$590
No LabVIEW
drivers

Antenna
bracket sold
separately
$36
Vibration plate
$150

M2 Inc.

OR2800PXA
Z

4200 in lb.
very heavy
duty

RS-232
included

Mast and
bracket not
included

$2,600

Mast and
bracket not
included

$400

No LabVIEW
drivers

Anaheim
Automation

23MDSI306
D-04

15 in lb.
light duty

RS-485
RS-232
converter
sold
separately
$140
No LabVIEW
drivers
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2.3 The FS-121 Positioner
Even though it exceeds the planned budget, the FS-121 Azimuthal Positioner
from Sunol Sciences combines the best features with the best price. It communicates
with easily programmed ASCII serial commands. It is accurate and rated to <1º
resolution and repeatability with a 10-lb. load limit. Compared to less expensive options,
it requires no assembly, stands on a single component with a small footprint, and has the
robustness of a more expensive unit. Extra funding from the EE department made it
possible to purchase the positioner with money left over. Sunol Sciences is a small
company located in Dublin, CA that manufactures positioning equipment and antennas
for EMC and wireless testing. The EE department has ordered from them in the past for
its 20’ anechoic chamber, and they offer helpful customer support.
The FS-121 is a floor unit with interchangeable acrylic masts to support a variety
of antennas. Figure 12 shows the two masts included with the FS-121: a custom mast
with antenna fixture and a standard mast with turntable. The custom fixture rolls either
direction for antenna polarization, and the center of the roll axis is at chamber mid height
50” above the floor. The fixture secures antennas on a circular flange with eight 9/32”
diameter mounting holes, spaced 45º apart in a 5” diameter. Wooden adaptors facilitate
flange-mounting antennas. See Appendix B for custom fixture and flange schematics.
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Figure 12 FS-121 Positioner with Custom Mast (Left) and Turntable (Right)

While the custom mount securely holds antennas at chamber mid-height, if an
antenna exceeds its size or weight ratings (1 m3, 10 lbs.) it can wobble when steprotating. In this case, it is important to check that excessive wobbling does not occur,
thus ruining the accuracy of the test. Larger antennas are not recommended for this
reason. However, for larger antennas, or antennas not compatible with the flange mount,
one should modify the turntable to hold them. Correctly securing antennas to the fixtures
designed for the chamber increases test accuracy and repeatability. Securing antennas
with nylon nuts and bolts, as opposed to steel or aluminum, prevents the hardware from
interfering with the test.
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2.4 Stationary Antenna Fixture
The custom stationary antenna fixture, or non-remote controlled fixture, securely
holds antennas up to 20 lbs. Only the chamber opening (24” x 24”) limits antenna size.
The wooden fixture has minimal EM interference, and caster wheels enable easy
movement. A 2” diameter dowel supports the mount flange and can roll to change
polarization as well as move in and out of the mast fixture to alter antenna separation
distance. The mount flange has the same hole pattern as the AUT fixture and wood glue
with a single wood screw fixes it to the dowel. Design schematics are available in
Appendix C.

Figure 13 Receiver Fixture with Horn Antenna
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2.5 Vector Network Analyzers
The Microwave Lab has six Anritsu VNAs designated for teaching labs and three
multipurpose HP network analyzers with S-parameter test sets. Ultimately, the VNA
determines the operating frequency range of the system. Wider bandwidth VNAs are
desirable. Table 2 lists Cal Poly’s VNAs and their availability for this project.
Table 2 VNA Models, Frequency Ranges, and Availability
Make and Model

Count Frequency
Range

Current Use

Calibration

Anritsu MS4622B 5

10 MHz to 3
GHz

Microwave Lab Good
Student Labs

Anritsu MS4623D 1

10 MHz to 6
GHz

Microwave Lab Good
Student Labs

Anritsu MS4624D 1

10 MHz to 9
GHz

Special
Applications

Hewlett Packard
8753ES

1

30 kHz to 6
GHz

Microwave Lab Reference
None
Only

Hewlett Packard
8753C

1

300 kHz to 6
GHz

Microwave Lab Reference
None
Only

Hewlett Packard
8753A

1

300 kHz to 3
GHz

Microwave Lab Good
None

Hewlett Packard
8720D

1

50 MHz to 20
GHz

Hangar Lab

Good

Good

The 20 GHz HP model has the highest upper frequency limit, but it is currently
exclusively used for Cal Poly’s 20’ anechoic chamber. Nevertheless, the 9 GHz Anritsu
has the bandwidth to accommodate most projects including those dealing with AM, FM,
GSM, GPS, NFC, PCS, Wi-Fi, and Bluetooth. For versatility, the AMS software works
with any of the Anritsu models, and the HP 8753ES. Because the code is modular, users
can later add support for other models. More on the control software in the next chapter.
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CHAPTER 3: LabVIEW Control System

LabVIEW is a graphical programming language from National Instruments that
uses graphical user interfaces (GUIs) called front panels to operate unseen code block
diagrams. Each front panel and block diagram pair is known as a virtual instrument, or
VI, and can call any number of other sub-VIs. LabVIEW controls instruments using the
Virtual Instruments Software Architecture standard (VISA) and the Standard Commands
for Programmable Instruments syntax (SCPI) over a variety of protocols including GPIB,
Serial, USB, and Ethernet. Programming instruments remotely allows access to all
normal functions of an instrument, with finer detail, and the ability to export data directly.
Instrument drivers for LabVIEW are available for free from the National Instruments
website www.ni.com. LabVIEW is the software of choice for test and measurement
automation in the electrical engineering field. It’s graphical interface makes it easy for
new users, as well as the software engineer who programs it.
The AMS uses LabVIEW to calibrate the VNA, capture S-parameter data, rotate
the antenna positioner, and save the data to files. LabVIEW also calls Matlab functions
to graph S-parameter data of polar plots and evaluate HPBW and directivity. The top
level “AMS.vi” unites these features into a single user interface. Furthermore, this top VI
compresses into a single executable file that can be run on any computer that has the
free LabVIEW Run-Time Engine (RTE) and National Instruments VISA drivers.
The AMS GUI organizes information into four tabs alongside a panel for status
and connectivity settings/indicators. The four tabs include: Calibrate VNA, S-Parameters,
Radiation Pattern, and Positioner Controller. The following four sub-sections and Figures
14-17 present a detailed explanation of each tab and their features. The logic flowchart
for the LabVIEW AMS can be seen in Appendix D.
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3.1 Calibration

Figure 14 LabVIEW AMS Front Panel: Calibration

Remote calibration follows the same procedure as manual calibration except the
settings are all located on one computer screen. Numeric controls specify the start and
stop frequency, while menu controls specify the calibration type, connector type, and
connector gender. LabVIEW compiles these settings into an SCPI command sequence
and a “Run Calibration” button sends the command sequence to the VNA. For each
calibration standard (open, short, broadband, through line) a Measure Device dialog box
pops up in LabVIEW. The VNA indicates which calibration standard(s) to connect, and
clicking “OK” in the dialog box triggers the VNA to measure the device(s).
Calibration accounts for losses in the coaxial cables and air between the
antennas for accurate transmission measurements. During full 12-term calibration, point
the AUT at boresight with the standard gain antenna, and use this as the through line
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reference. This ensures that S21 measurements will be normalized to the main beam
strength. Also, note the user must manually calibrate the HP network analyzer because it
is already simple to do manually. When the AMS detects the HP network analyzer, it
disables the calibrate VNA tab.

3.2 Measuring S-Parameters

Figure 15 LabVIEW AMS Front Panel: S-parameter Measurement

S-parameter measurements form the foundation of the antenna measurement
system. Numeric controls in the S-Parameters tab specify which S-parameter to
measure, as well as the start and stop frequency, and polarization when applicable. If
S11 or S22 are selected, LabVIEW disables the polarization control. Disabling certain
controls not necessary for specific modes helps users focus only on relevant settings.
Software prediction and ease of use features such as this are discussed in section 3.5.
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LabVIEW calls the VNA - Measure S-Parameter sub VI which configures the
channel layout, active channel, channel graph type, sweep range, starts the sweep, and
then reads channel data from the connected VNA. Next, the main VI adds a header to
the data and saves it as a tab-delimited text file to a user specified results folder.
LabVIEW generates the file name from the test settings and displays it below the graphs
on the main front panel. Underscores instead of spaces to make the file name more
compatible with post-processing programs. Plots on the front panel display log
magnitude in dB as well as signal phase.

3.3 Radiation Pattern Sweep

Figure 16 LabVIEW AMS Front Panel: Radiation Pattern (uncalibrated)

A radiation pattern sweep is composed of repeated transmission measurements
synchronized with AUT rotation. This is the heart of the test software. The system takes
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an averaged S21 measurement for each step along the 360º rotation of the AUT. The
user specifies the step size as well as the total sweep span in degrees, but the default is
1º steps over a 360º span. The system starts by moving the AUT to the -180º position,
facing away from the receive antenna, then steps clockwise as seen from above through
0º and finishing at +180º. After the sweep, the positioner returns counterclockwise to 0º
and the test results are saved to a text file. If the user specifies a sweep span smaller
than 360º, such as 90º, the system will sweep from -Span/2 to +Span/2, e.g. -45º to
+45º. Measurements are always centered about the 0º position, the direction facing the
receive antenna. A reduced sweep saves time when taking multiple measurements
where only the main beam of the antenna is important. In cases where the antenna
pattern is unknown, users should perform a full 360º sweep.
The system displays an S21 Magnitude plot as it records each data point so
users can verify that measurements are as expected as the test progresses. As soon as
the user clicks the start button, labeled “Run Rad Pattern Test”, it becomes a “Cancel
Sweep” button. The “Cancel Sweep” button throws out any collected data and returns
the positioner to 0º, completely reinitializing the test. It is also possible to export any plot
in LabVIEW directly from the front panel by right clicking and selecting “export data to
Excel.” This is a useful feature for examining specific data points.
The AMS only allows radiation pattern sweeps in constant wavelength (CW)
mode. This cuts down on system complexity and sweep time. Shorter sweep times allow
more time for designing systems instead of testing them. When the user inputs a
measurement frequency, LabVIEW returns the nearest calibrated frequency point. Next,
the user must specify the polarization of the antennas as H-Plane or E-Plane and
copolarized or cross polarized. The actual frequency and the polarization mode are
written into the name of the file when LabVIEW saves the data.
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Once a sweep completes, LabVIEW saves the S21 vs Phi Angle data in tabular
format and post processing can begin. LabVIEW calls one Matlab script to calculate
HPBW and directivity, and another to graph the radiation pattern on a polar plot. These
Matlab scripts are described in section 3.6.
To only measure relative power, a “Normalize” button tells Matlab to subtract the
peak value from the rest of the measurements. This sets the plot axis min to 0 dB and
max to -infinity with respect to the main radiation direction. This is particularly useful
when the antenna pattern is unknown beforehand. A fully calibrated measurement can
be run afterward.
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3.4 Positioner Controller

Figure 17 LabVIEW AMS Front Panel: Positioner Controller

The Positioner Controller tab helps set up the start location of the FS-121
positioner. It has all the controls necessary to orient the AUT before scanning. UI buttons
step the positioner clockwise or counter clockwise, as seen from above, and another
button zeroes out the positioner once it has reached the desired start location. A large
numeric indicator displays the positioner’s current angle. Although the positioner can
rotate indefinitely, steps are limited to a max of 360º. There is also a “Stop Rotating”
button to prevent the positioner from over rotating and damaging any cables. The
numerical step size controls are limited to prohibit large or negative numbers that would
otherwise damage the equipment. Even with these prevention features, the user must
take care not to over rotate the positioner. Also, note that when the positioner is first
powered on or initialized, it reports its location as 0º.
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3.4.1 Auto Locate Boresight
One special feature of the Positioner Controller tab is the “Auto Locate Boresight
Position” button. This button calls a sub VI that steps the positioner until it locates the
strongest transmission point between the two antennas for a given frequency. It
assumes the antennas are properly mounted and connected to the VNA, then uses a
basic peak search algorithm. The system steps the AUT in fractional degree steps until it
finds a peak in S21. The algorithm only locates the first maximum it comes across. It is
not sufficiently intelligent to ignore pattern lobes other than the main beam, so one must
point the AUT in the general direction of the receive antenna first. The default step size is
0.5º, but is user adjustable. Greater step sizes can be less accurate because they could
overlook the main peak. On the other hand, finer step sizes can be less accurate
because small peaks can be mistaken for the main peak.
The auto locate function is most useful when one knows the antenna’s general
pattern before testing. Once the algorithm locates a peak, an indicator next to the button
turns green and the positioner is reinitialized to 0º. The auto locate feature can make
aligning the AUT a single click process.
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3.5 UI Features and Smart Controls
The AMS VI has intelligent indicators and prediction features that make it fast
and friendly for new users.

3.5.1 Status Indicators
A status cluster in the bottom left corner of the main VI conveys all vital operating
information. It includes the elapsed time, a main indicator light, and a general text
display. The main indicator light starts off red, turns yellow during a test or initialization,
and turns green once the system is ready for a test. The general text display provides
more information such as which instrument LabVIEW is initializing, whether the program
has encountered an error, what that error is, and which test the system is running.
During the radiation pattern test, the status box also displays the last azimuth angle
measured.
Each tab also features its own indicator light and text display to provide yet more
information. For example, the Calibrate VNA tab displays a red light and the text
“Possibly Uncalibrated” when the calibration procedure has not yet run. It displays a
yellow light and the text “Calibrating” while a calibration is in progress. Intelligent status
indicators keep the user informed, increasing their comprehension of each test.

3.5.2 Intelligent Initialization
To communicate with external instruments, LabVIEW needs to know the
hardware addresses and limitations of those instruments. Normally the user must
manually enter the instrument VISA addresses, but this can be confusing for users who
do not need to understand this underlying process. Having a fixed VISA address will not
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work all the time either because GPIB and USB addresses can change. Instead, the
AMS intelligently identifies and initializes any properly connected equipment.
After clicking the run arrow, the main VI searches for the positioner and any
known VNA connected to the computer. The VNA - Find VISA sub VI first identifies all
active GPIB VISA addresses to narrow the search. Then it calls the VNA - Get Model VI
to query each instrument’s manufacturer until it finds Anritsu or Hewlett Packard. The
Positioner - Find VISA sub VI builds an array of all possible COM ports, or serial ports
(COM1, COM2, COM3, etc.) and loops until it recognizes the positioner and returns its
unique address. As a check, if the VNA or positioner VISA addresses are still empty, a
window pops up telling the user to select an instrument. Also at this point, AMS Main
initializes all front panel indicators depending on the identified VNA model. For example,
if the system recognizes the Anritsu MS4622B (see Table 2), it will limit user input for any
frequency controls to between 10 MHz and 3 GHz. This protects the system from users
entering frequencies that instrument is incapable of.
Similarly, for LabVIEW to access the Matlab post-processing scripts, it needs a
pointer to the directory where they are located. Because the LabVIEW executable can
be installed in any directory on any machine, this pointer needs to be dynamic to change
with each install. When a user downloads the AMS.zip file, the scripts are included in the
Matlab Scripts folder. LabVIEW automatically finds this folder using a built-in function to
acquire its current working directory and append the known file names to that path. For
this reason, it is important to maintain the folder hierarchy of the download.
Finally, LabVIEW attempts to initialize the VNA and Positioner. Initializing the
VNA consists of a software reset to return the instrument to a known state. Initializing the
antenna positioner consists of clearing its communication buffer. If either initialization
fails, a pop up window tells the user to check connections and power cycle the
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malfunctioning instrument. This self-diagnostic feature saves time by pointing to a
specific instrument and giving specific instructions to remedy it.

3.6 Matlab
After a radiation pattern sweep, LabVIEW saves the S21 Magnitude and azimuth
angle data to a tabular file. LabVIEW then calls two Matlab functions in series to graph
the data on a polar plot and calculate the pattern directivity and HPBW. While LabVIEW
can perform these operations within its native environment, its graphical data flow style
is more suited to data collection rather than data processing. Matlab is highly capable at
processing large amounts of data, and a few simple lines of code can replace a nest of
wires and blocks in LabVIEW. Also, one can call these Matlab functions independently of
the LabVIEW environment to reprocess already collected or modified data files. Matlab
source code can be found in Appendices F and G.

3.6.1 Radiation Pattern Plot
RadPatternPlot.m calls dirplot.m to graph radiation pattern data from a file
recorded with the Cal Poly LabVIEW AMS. dirplot.m is an open source Matlab function
available online [23] that modifies Matlab’s “polar” function to graph data on a negative raxis. Inputs to RadPatternPlot.m include the data file, plot style, and the option to
“normalize” as described in section 3.3. A radiation pattern data file should be three
columns: angle, magnitude, and phase, ordered from -180º to +180º. Radiation pattern
plots appear with 0º in the North direction and represent the antenna pattern as viewed
from above the test fixture. RadPatternPlot.m does not return any values, and the user
must manually save the plots it generates.
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3.6.2 Directivity
Directivity.m calculates HPBW and directivity from radiation pattern data. HPBW
gets extrapolated into a solid beam angle then used to estimate directivity. The function
expects data in the same format as RadPatternPlot.m, from 180º to +180º. Directivity.m
first finds the peak magnitude of the data, then it finds the first point on either side of the
peak where the magnitude drops 3.01 dB below the maximum. Generally, a smaller step
size produces more accurate results.
While a smaller step size provides more data points to analyze, it makes the test
take longer to complete. To reduce test time Directivity.m and RadPatternPlot.m accept
partial patterns (e.g. -90º to +90º) as long as they include half power points on either
side of the main beam. Calculations for solid beam angle and directivity can be seen in
the Matlab script in Appendix G.
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CHAPTER 4: Results and Verification

The goal of this project is to produce an antenna measurement system that
meets or exceeds the performance of Cal Poly’s existing 20’ anechoic chamber. To verify
the new anechoic chamber and its LabVIEW code, results from it must be compared
against results taken from identical measurements made in the existing chamber. This
chapter compares data from four different pairs of antennas measured in the same style
in both the Microwave Lab’s new chamber and the Hangar Lab’s existing chamber. The
results are referred to as “Microwave Lab” data or “Hangar Lab” data. The method for
measurement is a 360º rotation sweep with measurements at 1º steps. Both chambers
are evaluated on their representation of each antenna’s radiation pattern when
compared to an ideal antenna mathematical model. If the Microwave Lab data fits the
mathematical model as well as or better than the Hangar Lab data, the new AMS will be
considered a success.
Furthermore, the chamber which produces radiation patterns for each antenna
closest to their respective mathematical model will be declared most accurate,
notwithstanding unforeseen measurement errors. The simple mathematical model for an
antenna takes into account the length of the main transmitting surfaces of the antenna
and predicts how the radiation from those sources will combine in the far field to create
nodes and nulls. The chambers can be evaluated by their detection of the predicted
nodes and nulls. This model is discussed further in section 4.2.
One last consideration when undertaking this comparison is the fact that the
Microwave Lab chamber is about half the size of the Hangar Lab chamber. One can
anticipate the differences between two antenna measurement systems that are similar in
every way except for the size of their anechoic chambers. A larger chamber must have
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some sort of advantage over a smaller chamber, otherwise there would be no need for
such large, expensive chambers. After all, the goal of using an anechoic chamber is to
simulate a large open space.
Other than the obvious answer that the larger chamber can fit larger antennas,
larger chambers also have the advantage of greater antenna separation distance. A
greater distance between the antenna under test and the probe detecting its radiation
allows for more wavelengths between the two, to better measure the far field radiation
pattern. This means that lower frequency antennas with longer wavelengths are better
accommodated by larger chambers that can put more wavelengths between the antenna
and the probe. However, there is a trade off. Greater separation distance means that
less power gets delivered to the probe, as the probe takes up a smaller arc area of the
AUT’s radiation at that distance. The result is an S21 signal that gets buried in the noise
floor of the system, and greater power via amplification is needed going into the AUT to
bring the signal above the noise. An amplifier adds parts, cost, and complexity, but
nonetheless that is the trade off. Below is a table of the expected differences between
large and small anechoic chambers.
Table 3 Differences Between Small and Large Anechoic Chambers
Smaller Chamber

Bigger Chamber

Less expensive

More expensive

Can only measure smaller
antennas

Can also measure physically
bigger antennas

Can only measure antennas at
higher frequencies

Can also measure antennas at
lower frequencies

Usually does not require an
amplifier to maintain SNR

May require an amplifier to
maintain SNR
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4.1 Choosing the Antennas
There are four constraints to qualify antennas for use in this comparison test.
First, each antenna must come in a matching pair. Although it is not necessary to use the
same antenna to receive a signal as was used to transmit that signal, using the same
antenna is one way to be sure that the transmission can be detected if a broadband RF
detector is not available. In this case, using a pair of identical antennas also offers more
flexibility in choosing which frequency to transmit over choosing two different antennas
because both antennas have the same operating frequency range. What one antenna
transmits, the other antenna is guaranteed to be able to receive, so long as they are in
the co-polarized configuration.
Second, each antenna must operate partially within the VNA limit. Even though
the VNA in the Hangar Lab has an upper frequency limit of 20 GHz, antennas are limited
to the lowest common maximum frequency between the VNAs in each lab. This is
because the two labs are too far to move the sensitive and expensive 20 GHz VNA
between them. The VNA in Microwave Lab has an upper frequency limit of 6 GHz, and
this is the limit for this test.
Third, the antennas must be small enough to fit inside the Microwave Lab
Chamber because it is the smaller of the two chambers. The Microwave Lab Chamber
can only accommodate an antenna up to 0.6 m in any dimension because of the size of
the openings and load capability of the robotic positioner.
Finally, the fourth constraint is due to the length of the Microwave Lab anechoic
chamber. The distance between the two antennas must be long enough so the antennas
are in the far field. Although frequency alone does not dictate the far field distance, it is
closely related. Because lower frequencies have a longer wavelength, the max possible
separation distance decides the minimum frequency. Far field is also a factor of
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aperture, or the largest transmitting surface of the antenna. Larger antennas have longer
far field distances, requiring them to being measured in larger chambers. Far field
calculations are available in Appendix A. As a result, only antennas with a far field
distance less than or about equal to 1m are allowed. Table 3 shows the selected
antennas and the frequencies at which they were tested, as well as their far field
distance.

Table 4 Antennas for Chamber Verification
Antenna

Operating
Range

Frequency
Tested

Far Field
Distance

Narda 642
Standard
Gain Horn

5.40 - 8.2 GHz

5.5 GHz

46.86 cm

Narda 643
Standard
Gain Horn

3.95 - 5.9 GHz

5.0 GHz

79.05 cm

915 MHz
Patch

915 MHz
(narrowband)

915 MHz

12.82 cm

Broadband
Horn

0.7 - 18 GHz

3.0 GHz

101.25 cm
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4.2 Mathematical Model for Nodes and Nulls

Figure 18 Far Field Parallel Ray Approximation

One can estimate the far field patter of an antenna by treating the points on its
surface as independent, phase-locked sources. Calculating how signals from these
sources combine in the far field identifies nodes where total emission is strongest, and
nulls where it is weakest. Consider a radiating horn antenna. Electromagnetic waves
emanate from either side of the aperture where they are initially 180º out of phase.
When the difference in distance traveled by the two signals to reach a single point is an
integer multiple of one wavelength, their power will cancel out creating a pattern null.
Correspondingly, when that difference is an odd integer multiple of a half wavelength,
their power will combine to create a pattern node. Using the far field parallel ray
approximation illustrated in Figure 18, this difference is calculated as Dsin(θn) where D is
the distance separating the two sources, and θn is the angle of the parallel emissions
away from the normal vector of the antenna. Setting this equal to n*λ and n*λ/2 and
solving for θn yields the following equations for the antenna pattern’s node and null
angles.
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θ! null = sin−1

nλ
, wh ere n = 1, 2, 3, …
(D)

Equation 6

nλ
, wh ere n = 1, 3, 5, …
( 2D )

Equation 7

θ! node = sin−1

The hand calculation method is useful for verifying patterns recorded by an AMS.
For more detailed pattern analysis, 3D computer modeling tools such as Keysight’s
Advanced Design System (ADS) and Ansys’ High Frequency Structural Simulator
(HFSS) use finite element analysis to produce simulated field patterns. Table 4 shows
the calculated far zone and the first two nodes and nulls of the antennas available in the
Microwave Lab.
Table 5 Antenna Far Field Distances and Nulls
Antenna Frequency Aper- λ (cm) Far
Model
ture
Zone
(cm)
(cm)
Narda
642

5.5 GHz

Narda
643

5.0 GHz

Narda
644

2.4 GHz

BB
Horn

3.0 GHz

915 MHz 915 MHz
Patch
2.4 GHz
Horn

2.4 GHz

First
Null

Second First Second
Null
Node Node

11.3

5.45

46.86

28.8º

74.7º

13.9º

46.3º

15.4

6.00

79.05

22.9º

51.2º

11.2º

35.8º

23.1

12.50

85.38

32.8º

—

15.7º

54.3º

22.5

10.00 101.25 26.4º

62.7º

12.8º

41.8º

14.5

32.79

12.82

—

—

—

—
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12.50

92.16

31.4º

—

15.1º

51.4º

4.3 Radiation Patterns Graphed on Polar Plots
First consider the polar plots of the antenna radiation pattern data. Polar plots,
compared to XY plots, are good visualizing how the antenna actually transmits, and they
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are good for highlighting nodes and nulls. The Microwave Lab system automatically
generates polar plots via Matlab, but the Hangar Lab system only generates a tabular
data file. To ensure a fair comparison, polar plots of the data from the Hangar Lab were
generated using the same Matlab script as the Microwave Lab Data. In the following
plots Microwave Lab data is blue and Hangar Lab data is red. Data is presented in dB
and both traces are on the same scale.
1st Node at ±13.9º
1st Null at ±28.8º
2nd Node at ±46.3º

2nd Null at ±74.7º
-9

Figure 19 Polar Radiation Pattern Plot of the Narda 642 Horn Antenna at 5.5 GHz as
Measured by the Microwave Lab Chamber (Blue) and Hangar Lab Chamber (Red), and
Predicted 1st and 2nd Nodes (Green) and Nulls (Black)

In Figure 19, both chambers accurately measure the main beam of the the Narda
642 Horn antenna. The predicted nodes at ±13.95º lie on top of the main lobe, and this is
as expected because the main lobe is technically the first node. Next, the first predicted
null does not line up perfectly with a measured null from either AMS, however both
patterns experience a drop in S21 at 37º, within 10º of the estimated location. The null is
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more apparent in the Hangar Lab AMS with a drop of -20 dB at the null versus the
surrounding pattern. Meanwhile the Microwave Lab pattern shows less of a distinct
notch at this angle but more of a gradual decline until the subsequent node angle. The
second nodes and second nulls line up with both antenna patterns, yet they are again
more apparent in the Hangar Lab measurement than in the Microwave Lab
measurement.
One possible explanation for this null magnitude difference between the two
measurement systems, ignoring the additional noise in the Hangar Lab data, is that the
Hangar Lab is larger and puts more distance between the two antennas. A greater
distance between the antennas gives their radiation more space to interfere with itself,
thus accentuating the nodes and nulls.

1st Node at ±11.2º

1st Null at ±22.9º

2nd Node at ±35.8º

2nd Null at ±51.2º
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Side lobes <-30dB

Figure 20 Polar Radiation Pattern Plot of the Narda 643 Horn Antenna at 5.0 GHz as
Measured by the Microwave Lab Chamber (Blue) and Hangar Lab Chamber (Red), and
Predicted 1st and 2nd Nodes (Green) and Nulls (Black)
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Moving on to the second antenna, the Narda 643 horn, the pattern has a more
focused main beam at 5.0 GHz compared to the Narda 642 horn at 5.5 GHz, with a
HPBW of nearly 10º versus 15º of the 642. The 643 Horn also has fewer to no side lobes
outside of ±60º above the -30 dB level. Both measurement systems accurately detect
the predicted nulls and nodes. Again, the first nodes lie in the main beam. The first nulls
contain 10 dB less power than the 0º direction. The second nodes are given away by a
decrease in the negative slope in each of the measurements at ±35º. The second nulls
lie around 30 dB below the 0º direction. Despite the accuracy of the Hangar Lab AMS in
measuring nodes and nulls, it records sharp discontinuities on the order of 10s of dB
inconsistent with the parallel ray approximation model. This noise hints that one or more
of the model’s assumptions are wrong in the Hangar Lab.

1st Node at ±12.8º

1st Null at ±26.4º

2nd Node at ±41.8º
2nd Null at ±62.7º

-9

Figure 21 Polar Radiation Pattern Plot of the Broadband Horn Antenna at 3.0 GHz as
Measured by the Microwave Lab Chamber (Blue) and Hangar Lab Chamber (Red), and
Predicted 1st and 2nd Nodes (Green) and Nulls (Black)
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Here, both chambers showed the broadband horn antenna is not as directive as
either of the first two horn antennas, with a HPBW of 24º. This is as expected because in
order to achieve good broadband performance, the antenna must give up some of its
gain. Both chambers recorded a well defined second null at ±62.7º with 1º-3º margin of
error. This error could be due to initial alignment and setup of the antenna under test.
The first two nodes lie in the main beam, and the first null does not have much of an
effect on the main beam. The reason this antenna is so broadband is because it is
designed with many levels of emitting surfaces instead of a singular monolithic design
like the previous two antennas. This makes its radiation pattern much more complex to
predict and requires the use of computer modeling to calculate. Fortunately, it is just as
easy to measure in the anechoic chamber. Figure 22 shows an example of the type of
broadband horn used in this test. The interior ridges and bars lining the exterior work to
enable multiple resonating modes for different sections of its operating frequency range.

Figure 22 A Double Ridged Broadband Horn Antenna
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Nearly isotropic
beam pattern
between ±90º

-9

Less power
radiated in reverse
direction

Better side lobe
separation in
Hangar

Figure 23 Polar Radiation Pattern Plot of the 915MHz Patch Antenna at 915 MHz as
Measured by the Microwave Lab Chamber (Blue) and Hangar Lab Chamber (Red)

The last antenna is a 915 MHz patch antenna. Patch antennas are known for
being very narrow band, and having a relatively isotropic beam pattern, but only in one
direction. At 915 MHz, this antenna does not have any real valued nodes or nulls,
however it is not expected to radiate well in the reverse direction. Both chambers confirm
this expectation with smooth beam patterns until the 90º mark. The Hangar Chamber
records better separation of the reverse direction side lobes, whereas in the Microwave
Lab Chamber these lobes are not as defined and blend together. This is consistent with
the theory that a larger chamber will produce better separation of the side-lobes because
of its greater antenna separation distance.
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4.4 Realizations about Calibration Procedure
Now examine data from just the Narda 642 horn graphed on an XY scatter plot to
gain a different perspective. The XY plot can better show data from each chamber in the
original S21 loss level as measured by the VNA, whereas the data before was
normalized with respect to the main beam.

Hangar Lab

Figure 24 Power vs Azimuth Scatter Plot of the Narda 642 Horn Antenna at 5.5 GHz as
Measured by the Microwave Lab Chamber (Blue) and Hangar Lab Chamber (Red)

Figure 24 shows an unusually large 57 dB difference in the transmission loss
recorded by both chambers. Because the Hangar Lab chamber is larger and the
antenna separation distance is greater, it is expected that the transmission loss there
would be somewhat greater than that of the Microwave Lab chamber. However, after
analyzing this data, it became apparent that parts of the measurement procedure for
each chamber were incorrect. The difference in separation distance between the two
chambers is not great enough to justify the 57 dB difference in main beam transmission
loss. The separation distance in the Hangar Lab is about 2.5x the separation distance in
the Microwave Lab. Using the rule that radiative power decreases at a r^2 rate from the

47

source, we can estimate that the difference in log magnitude transmission loss between
the two chambers for a given pair of antennas should be about 10*log(2.5^2) or 8 dB.
The main discrepancy between the test procedures for each chamber was the
calibration procedure and the VNA settings. The calibration procedures for each
chamber previously were as follows.
Table 6 Original Calibration Procedure for Both Antenna Measurement Systems
Calibration Step

Microwave Lab

Hangar Lab

Broadband Load 50 ohm load at the end of each cable

Not measured

Short

Short terminator at end of each cable

Not measured

Open

Open terminator at end of each cable

Not measured

Through Line

Connect both antennas, point them at Not measured
each other, and measure

Isolation

Omitted

Not measured

Previously, in the Hangar Lab, it was assumed that the VNA need not be
calibrated before measuring an antenna pattern. This is the way tests had always been
run there. The theory was that because all the measurements taken during a radiation
pattern scan are relative to each other, calibration was not necessary. However, this
assumption was soon proven false, calibration does matter. This also explains why the
Hangar Lab data was much noisier across all measured angles compared to the
Microwave Lab data which had at least some form of calibration. The sharp
discontinuities and asymmetries exhibited in the Hangar Lab data turned out to be a
result of the missing calibration.
After calibrating the VNAs in both chambers in an identical fashion, the results
from both chambers were much more similar to each other and were consistent with
theory. Additionally, less noise, and more symmetrical patterns were observed. The new
calibration sequence for both chambers, a full 12-term calibration, is as follows.
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Table 7 New Calibration Procedure for Both Antenna Measurement Systems
Calibration Step

Microwave Lab and Hangar Lab

Broadband Load

50 ohm load at end of each cable

Short

Short terminator at end of each cable

Open

Open terminator at end of each cable

Through Line

Connect the ends of both cables together

Isolation

Omitted

New measurements were taken with the antennas that were still available using
calibrated equipment. Additionally, noise floor measurements for each antenna were
taken to show the accuracy of the weakest points of the measured patterns. A noise floor
measurement is performed by connecting a 50 ohm load to the end of the cable going to
the antenna under test and then measuring S21 like normal.
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4.5 New Antenna Patterns with Calibrated Equipment
Narda 642 Horn Antenna Radiation Pattern at 5.5GHz
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Figure 25 XY Scatter Plot of Narda 642 Horn Antenna Pattern Measured in Both
Chambers with Noise Floor, Nodes and Nulls

First look at the Narda 642 antenna. With proper calibration, the difference in
transmission loss between the two anechoic chambers becomes 7.5 dB at 0º and 7.7 dB
on average overall. This is line with our estimation of 8 dB in the previous section,
reassuring that the data is now correct. We can also see that the nulls and nodes,
particularly the first two nodes and the first nulls line up with recorded pattern from both
chambers. The patterns overall are very similar, however the pattern from the Microwave
Lab chamber appears less symmetrical and more noisy in the reverse facing side lobes
beyond the ±90º mark in either direction.
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We can also view the noise floor in each chamber for the first time. The noise
floor is the level at which the VNA, given its current settings, cannot detect below. Ideally
the signal to noise ratio (SNR) will be very high. That being said, the measurements from
both chambers for this antenna are both mostly above their respective noise floor. The
noise floor in the Hangar Lab chamber is much lower, with less variance than that of the
Microwave Lab chamber, averaging -85.6 dB with a maximum of -80 dB, while that of the
latter averaged -75.5 dB with a maximum of -64.4 dB. What this means is that any
recorded signal below the maximum noise level has to be thrown out. The data from the
Microwave lab dropped below its noise floor maximum in a few places in the side lobes,
so those data points are not valid. It is good that the Microwave Lab chamber has a
shorter antenna separation distance because the increased signal level compensates for
the relatively higher noise floor there.
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Narda 643 Horn Antenna Radiation Pattern at 6 GHz
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Figure 26 XY Scatter Plot of Narda 643 Horn Antenna Pattern Measured in Both
Chambers with Noise Floor, Nodes and Nulls
Looking now at the pattern of the Narda 643 horn, we can see the comparison is
similar to that of the 642 horn. The Microwave Lab system recorded a 7.1 dB loss
difference at 0º from the Hangar Lab system, once again in line with our estimation of 8
dB. The nulls and nodes for both chambers line up well with the estimated pattern nulls
and nodes. Note that these nulls are newly calculated for this antenna at 6 GHz, as the
antenna was previously measured at 5 GHz. Here we can also see the noise floor for
both chambers creeping up to around -75 dB, but still well below most of the recorded
antenna patterns. We also see good symmetry in both chambers, however the patterns
begin to differ more around the rear facing side-lobes. Some of these differences could
be due to differences in the mounting hardware used in each antenna, as these begin to
have effect at lower power levels.
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915 MHz Patch Antenna Radiation Pattern at 915 MHz
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Figure 27 XY Scatter Plot of 915 MHz Patch Antenna Pattern Measured in Both
Chambers with Noise Floor

Finally, the 915 MHz patch is the last antenna remeasured, this is because the
broadband horn was no longer available. We expect to see more of the effects of using a
shorter antenna separation distance with this antenna because of the relatively low
frequency and longer wavelength compared with that of the Narda horns. As noted
earlier in section 4.1, a smaller chamber has a shorter antenna separation distance and
this means the antenna doing the detection may not be sufficiently in the far field zone of
the AUT. The effects of this are that the signals from the AUT are not approximately
planar, resulting in a more smoothed out antenna pattern. Less detail, for example in the
side lobes, of the antenna pattern will be visible. Looking at the results for the 915 MHz
patch antenna, this is shown to be true. The Microwave Lab data, although 7.5 dB
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stronger at 0º, shows only two distinct lobes: a primary beam and a reverse lobe.
Whereas the Hangar Lab, with its greater separation distance, records six: the primary
lobe, two new side-lobes, and a reverse lobe.
This is an interesting observation and gives additional insight and proof into the
benefits of a larger chamber. Although the Hangar Lab chamber is slightly less sensitive
at detecting a signal (7.5 dB), what it lacks in overall sensitivity, it makes up for in the
detail of side the lobes that the smaller chamber could not detect. The trade off in this
particular case paid off. The downside of less power reaching the RF probe due to a
larger antenna separation distance is that the recorded signal is then less powerful
relative to the noise floor, reducing SNR. However, since in this case the noise floor in
the Hangar Lab was well below (26.9 dB) the lowest recorded point of the antenna
pattern there, there was plenty of overhead to increase the antenna separation distance
even more.
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CHAPTER 5: Conclusion

Overall, the new Microwave Lab Antenna Measurement System measures
antenna patterns with good accuracy at close range all while being easy to operate.
Relative to its predecessor, the Hangar Lab AMS, it does some things better and some
things worse. While both chambers accurately record pattern nulls and nodes within 10º
of their estimated positions, the Microwave Lab system still struggled at the low
frequency with the 915 MHz patch, due to its shorter antenna separation distance. At
higher frequencies, above 5.5 GHz, the detail in the side lobes recorded by the
Microwave Lab system were on par with the larger Hangar Lab system. That is not to
say the Microwave Lab system is not going to be accurate at frequencies below 5.5
GHz, but rather the user should always estimate the far field distance of their AUT
beforehand to decide if the larger chamber is necessary.
The Hangar Lab also consistently showed a lower noise floor than the Microwave
Lab, meaning the 20 GHz HP VNA there has much greater sensitivity than the Anritsu
VNAs available in the Microwave Lab. This plays to the advantage of the Hangar Lab
chamber, being that it is of a bigger size it needs the extra sensitivity to detect lower
level signals that have decayed much more on their trip from the AUT to the receive
antenna. It should be noted that the 6 GHz HP VNA available in the Microwave Lab had
a much higher noise floor than the Anritsu models, and is thus not recommended for use
nor was it used in this comparison. Although the Microwave Lab exhibited a higher noise
floor in this comparison, the SNR was always greater than one over most of the swept
angles for each antenna.
In addition to measurement accuracy, the new system also includes more
extensive data post processing, and a more accurate antenna positioner. The compiled
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LabVIEW executable makes it easy for students to access and use, and the proximity of
the chamber to the rest of campus means it will get used more frequently.

Table 8 Summary of Expected vs Observed Differences and Similarities
Between Hangar Lab Chamber and Microwave Lab Chamber
Expectation

Observation

The Hangar Lab would have better
side lobe separation than the
Microwave Lab for lower frequency
antennas.

The Hangar lab did indeed have better
side lobe separation for the 915 MHz
patch, while side-lobe separation was
similar between the two chambers for
the higher frequency horn antennas.

The Microwave Lab would have a
similar noise floor level to the Hangar
Lab.

The Microwave Lab, with its 6 GHz
Anritsu VNA, had a higher noise floor
with a greater variance than the
Hangar Lab with its 20 GHz HP VNA.

The Microwave Lab would have 8 dB
less transmission loss than the Hangar
Lab due to its shorter antenna
separation distance.

The Microwave Lab actually measured
on average 7.37 dB greater signal
strength at boresight than the Hangar
Lab across the antennas measured.
This a reasonable margin of error
given the different antenna mounting
methods.

The Microwave Lab would run
radiation pattern scans faster.

The Anritsu VNA and Sunol Sciences
FS-121 in the Microwave Lab take
about 10 minutes to complete a
radiation pattern sweep, while the HP
VNA and Sunol Sciences ELAZ75 in
the Hangar Lab take about 30
minutes.

To sum up, the Microwave Lab AMS is a good substitute for the Hangar Lab
chamber when measuring smaller antennas with short far field distances. For larger
antennas, and antennas with longer wavelengths, the Hangar Lab remains the best. The
new AMS is an accurate and easy to use resource for science and engineering students
to learn more about antenna theory and operation in a way that contributes to the Cal
Poly “learn by doing” ethos. Even before the project’s completion, students were already
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asking about and using the automated measurement system and expressing positive
feedback. The ease of use and greater proximity to classrooms increases the likelihood
of students and teachers using an anechoic chamber, and an antenna design
experiment such as the one in the next chapter is a good way to get students started.
Additionally, the new LabVIEW interface is packed with features and displays information
in a way that helps students learn antenna theory.

5.1 Future Improvements
5.1.1 Antenna Separation Distance Tests
A good future experiment would be to measure an antenna in the larger Hangar
Lab chamber, but with the separation distance equal to that used in the Microwave Lab
Chamber. This would get rid of one more variable in the chamber-to-chamber
comparison. It would show whether the side lobe separation and noise artifacts are
dependent on the distance or the anechoic chamber environment. One step further in
this experiment would be to compare the pattern of an antenna at various separation
distances within the larger chamber, and plot them on one plot to show how the pattern
changes with distance.

5.1.2 Free Space Material Measurements
Anechoic chambers may be used for purposes other than antenna measurement.
It is possible to measure electric permittivity, magnetic permeability, and sheet
impedance of sheets of dielectric material by placing them in an anechoic chamber
between two antennas and measuring the S-parameters of this network. This method is
outlined in Focused Beam Methods: Measuring Microwave Materials in Free Space by
John W. Schultz, and requires dielectric lenses to focus antenna beams onto the
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dielectric material to minimize fringing affects at the edges of the material. Unfortunately,
due to time and financial constraints, implementation of this system was not possible for
this project and is therefore suggested for a future project.

5.1.3 Swept Frequency Radiation Patterns
It is possible, given a minor tweak in the LabVIEW code, for the AMS to measure
radiation patterns for a list or range of frequencies. This would work by programming the
VNA to measure a list of frequencies for each angle of rotation of the AUT, as opposed to
a constant wavelength, and then plot multiple traces or a 3D mesh for a single 360º
sweep. This idea was not implemented because it would increase complexity in a
system designed to be simple to use. The capability still exists for the user to run
multiple 360º sweeps for various frequencies of interest, however each frequency would
require a new AUT sweep. The user can decrease sweep time by increasing the
azimuthal step size, or decreasing the azimuthal span.

5.1.4 Time Domain Gating
Even though the anechoic chamber is designed to attenuate most microwave
reflections before they reach the receive antenna, low power reflections still occur and
can alter measurements. The vector network analyzer can filter out reflections by only
sensing a specific time domain window, or gate, of the incoming signal and ignoring any
parts of the signal that follow. This is known as time domain gating. Because reflections
travel a longer path than direct signals, they take longer to arrive at the receiving end.
For the new anechoic chamber, this amounts to a few nanoseconds of extra travel time.
The Anritsu network analyzers are, at best, capable of a 10-ns gate. Given that
the antennas in the chamber are no more than 1.5 m away from each other, the
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maximum time for direct transmission is approximately 5 ns. While some noise reduction
was apparent with a 10 ns gate, possibly due to the elimination of secondary and tertiary
reflections, more research and testing are required to determine what time domain gate
would best eliminate primary reflections while preserving the complete direct
transmission signal. One possible method for identifying reflections from direct path
transmissions would be to configure the network analyzer to display signals in the time
domain, and noting what time range the main burst of energy arrives. Furthermore, the
AMS program could automatically adjust the time gate for different sized antennas,
different antenna positioners, and different antenna angles. However, to keep the system
easy to use, and to focus on other aspects of the AMS, this feature was left out. The
user can still set up time domain gating manually before taking measurements if desired.

5.1.5 Chamber Calibration for Active Measurements
While the focus of this project was to establish a basic system capable of passive
antenna measurements, a highly useful addition would be to calibrate the anechoic
chamber for active wireless measurements. Active measurements involve testing an
antenna as part of a system that includes a power source, amplifiers, and other wireless
radio circuitry. Calibrating the chamber means quantifying the air loss between the DUT
and the receive antenna as well as the loss in the coaxial cables running to and from any
measurement equipment. With these values known, the system can calculate total
radiated power (TRP) or total isotropic sensitivity (TIS) while considering desensitization
of the antenna due to noisy components of the total system. These are industry standard
measurements for wireless communication devices and students would benefit from
learning more about them.
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CHAPTER 6: Creating the Antenna Design Experiment
Appendix H contains a laboratory experiment designed to introduce students to
using the antenna measurement system. The intention is for the lab to be part EE533
Antennas course, and it references most of its material from the course textbook
Antenna Theory and Design. The lab centers around designing, modeling, prototyping,
and testing a pyramidal horn antenna, but students can use the lab as a guide to build
any antenna they want. The goal of the lab is to get students comfortable with the
anechoic chamber and give them hands on experience with antennas.

6.1 Designing the Experiment
Antenna design and test laboratory experiments must specify the test
equipment’s frequency range, antenna physical size, and practical antenna test
procedures. This tutorial describes a 2.4 GHz pyramidal horn antenna design. The 2.4
GHz band covers Wi-Fi and Bluetooth, two standards of interest to students, and is
within chamber and test equipment frequency limits.
Because horn antennas require more time to construct than a milled patch
antenna, students will require more than one session for experiment completion.
Requiring all students to build and test their own antennas requires substantial materials
and more than one test session. To reduce time and resources, each student models an
antenna, but then works in groups of three for antenna fabrication. The experiment takes
three days: a day to model, a day to construct, and a day to test.
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6.2 The Design
Students will use design equations from section 9.4.3 The Pyramidal Horn
Antenna in Stutzman to design an antenna that results in practical physical dimensions.
Given the standard waveguide dimensions for that frequency range, students should
choose a gain value that yields a physically realizable ‘A’ dimension.

Figure 28 Pyramidal Horn Antenna Dimensions [1]

Section 9.4.3 in Stutzman contains all the necessary design equations and
background for the design, as well as an example design and a method to verify the
correct solution. The result should be a value for RP = RE = RH in cm.
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Below is a table of the standard waveguide sizes relevant to the 2.4 GHz range.
The S Band is on the list because although it does not specifically cover 2.4 GHz it is the
waveguide standard for the Narda 644 standard gain horn which will act as the source
antenna when testing the students’ antennas.

Table 9 Standard Rectangular Waveguide Dimensions [13]
Frequency Band

Waveguide
Standard

Frequency Limits
(GHz)

Inside Dimensions
(mm)

R Band

WR-430

1.70 to 2.60

109.22 x 54.61

D Band

WR-340

2.20 to 3.30

86.36 x 43.18

S Band

WR-284

2.60 to 3.95

72.136 x 34.036
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6.3 Modeling
Once the students have their design written down, they can follow the tutorial in
Appendix H to model their horn in HFSS. The tutorial is a bare bones guide to getting the
horn design on the computer quickly. The guide allows students to input their own
dimensions parametrically, making each design unique. After modeling, students will
produce 3D polar radiation plots and rectangular phi cut radiation plots which they then
export to a tab-delimited text file to compare to their physical design results. Figure 28
below shows an example of the final computer model. The antenna points along the
x-axis to reflect how it will sit in the anechoic chamber.

Figure 29 2.4 GHz Pyramidal Horn Model in HFSS

6.4 Prototyping
After modeling, students in groups of three will use copper clad board to build
their best design. Rogers Corporation provides free samples of their Duroid and FR4 for
student projects through their university sample program, and can source the materials
for the experiment. Since the design equations from Stutzman yield a value for RP, the
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length of the horn in the x-dimension, students need an equation to find the length of the
face of each panel. The equation below uses the Pythagorean theorem to calculate the
length of the H-plane panels from RP, B, and b, and will also calculate the length of the E
plane panels by substituting in A and a.

L ength of Panel A =

RP2

B−b
+
( 2 )

2

Equation 8

Students will then cut the copper panels to size, and solder them together. The
SMA connector should feed into a quarter wave monopole located in the center of the
waveguide width and one quarter wavelength away from the back panel to produce in
phase reflections. Figure 29 shows an example of what the final antenna might look like.

Figure 30 2.4 GHz Pyramidal Horn Antenna Prototype
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6.5 Validating the Design Procedure
Analysis of an antenna prototype designed for 12.6 dB gain at 2.4 GHz confirms
the design procedure produces a working antenna. Figure 29 shows this prototype. The
HFSS model represents an ideal antenna. Its S11 and radiation pattern are meant to be
design guides not actually achievable with a practical antenna. Figure 30 and 31 below
compare the HFSS model with data from the prototype measured with the AMS.

Figure 31 S11 Log Magnitude Plot Comparing HFSS Model to Prototype

S11 shows both the model and prototype below the VSWR threshold of 2, or
-9.54 dB, at 2.4 GHz meaning the antenna will effectively radiate at this frequency. The
model has a return loss of 20.42 dB and VSWR of 1.21 at 2.4 GHz and the prototype
has a worse return loss of 12.43 dB and VSWR of 1.63 at 2.4 GHz. The HFSS model
shows an average rejection below -20 dB throughout the 1.5 to 5 GHz band, but the
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prototype does not match exactly, achieving a VSWR less than 2 only between 1.8 and
2.5 GHz. Nevertheless, the prototype still meets requirements for the 2.4 GHz band.

Figure 32 Normalized Rectangular Logarithmic Radiation Pattern Comparing HFSS
Model to Prototype

The model’s radiation pattern is smoother with a narrower main beam and a
single back lobe, and the prototype has a slightly wider main beam with a pair of distinct
side lobes at ±150º along and a smaller back lobe. Using the Directivity.m function
discussed in section 3.6.2, the model horn has an estimated directivity of 18.35 dB and
an HPBW of 38º, while the prototype has an estimated directivity of 12.06 dB and an
HPBW of 47º. The prototype came considerably close to the original design goal of 12.6
dB gain, within less than 1 dB, assuming 100 percent radiation efficiency.
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The lobes at ±150º in the prototype data are likely due to the sides of the horn
flare transmitting unwanted radiation. These sides are facing normal to the receiver
antenna at ±150º. The model did not predict this because it assumes the materials are
perfect electrical conductors, minimizing coupling.
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APPENDIX A: Far Field Derivation

Figure 33 Geometry for Field Calculations of a Line Source

Given a line radiation source, at an observation point P at a distance r and angle
θ from the center of the source, radiation along a ray R drawn from the end of the source
to the observation point will exhibit a phase shift compared to radiation along ray r. This
phase shift will cause interference and one must consider this for observation points
sufficiently close to the source. Length R is calculated using the Pythagorean Theorem

Putting all points into the spherical coordinate system, the equation translates to

To develop approximate expressions for R, expand using the binomial theorem
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Figure 34 Parallel Ray Approximation for Far-Field Calculations of a Line Source

The Far Field is the range where the two rays are assumed parallel, or where the
effects of the third term of the expanded equation for R become negligible. This parallel
ray approximation simplifies the calculation of the phase difference between the two
rays. The third term of the expanded equation for R is considered negligible when it less
than or equal to a sixteenth of a wavelength. This corresponds to a phase error of

Using D as the length of the line source, the maximum value of the third term, or worst
case scenario, occurs when z’ = D/2 and θ = 90º. Setting this maximum equal to a
sixteenth of a wavelength gives an equation for the far field distance rff.

Solving for rff gives
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APPENDIX B: Custom Positioner Fixture Schematic
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APPENDIX C: Receiver Antenna Fixture Schematic
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APPENDIX D: LabVIEW AMS Flowchart
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APPENDIX E: AMS User Guide

LabVIEW Antenna Measurement
System User Guide

Cal Poly San Luis Obispo
Electrical Engineering Department
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Introduction
The Microwave Lab Antenna Measurement System (AMS) allows Cal Poly
students to measure antenna radiation patterns and s-parameters accurately and
conveniently in a laboratory environment. This user guide is meant to be an introduction.
It illustrates step-by-step how to make basic measurements. The methods in this guide
can be extrapolated to more advanced methods such as the gain transfer method for
measuring gain or the polarization pattern method for measuring polarization.

Figure 1 Drawing of the AMS
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Precautions
When working with the AMS, follow these precautions to avoid damaging any
equipment.

1. Please avoid touching the foam. Deformations alter its absorptive properties and it
can release particles into the air that are harmful if inhaled.
2. Use large radius bends when laying or coiling SMA cables. Sharp bends can
damage them.
3. Use masking tape to hold cables in place, such as near where they connect to the
VNA, or anywhere else they might move around or otherwise bend too sharply.
4. Get approval from Dr. Dean Arakaki before using the AMS for the first time. Dr.
Arakaki oversees the chamber and can assist you with your design.
5. Schedule your time wisely so to not interfere with any lab sessions that may need the
chamber.

Figure 2 Chamber Window

Figure 3 SMA Cable
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List of Equipment and Parts
The following instruments and parts are needed to run the tests in this guide.

• Vector Network Analyzer (VNA)
• Anritsu MS4623D Vector Network Analyzer (10 MHz - 6 GHz)
• Anritsu MS4622B Vector Network Analyzer (10 MHz - 3 GHz)
• HP 8753ES S-Parameter Network Analyzer (30 kHz - 6 GHz) (Ref Only)
• Sunol Sciences FS-121 positioner with mast or turntable
• PC with LabVIEW and Matlab
• Wooden receiver antenna fixture
• Antenna Under Test (AUT)
• Receiver antenna
• Two 16ft SMA male to SMA male coaxial
cables

• N male to SMA female adaptors
• 6ft RS-232 to USB cable
• 3ft GPIB to USB cable
• VNA calibration kit
• Hardware and tools for mounting antennas
• Masking tape

Figure 4 Parts Shelf

• Various wooden blocks
• Bubble level
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Getting Started
I.

Mount the receiver antenna
A. Bolt the antenna by its adaptor to the wooden
flange
1. Use washers to protect the surfaces
2. Nuts should only be hand tight
B. Connect the port 2 SMA cable to the waveguide
adaptor
1. Use an N male to SMA female adaptor as
Figure 5 Antenna Adaptor

needed
2. Do not over tighten
C. Move the fixture into position
1. Position the antenna with its aperture to the
chamber window cutout
a) For large antennas, remove the foam
window with the rectangular cutout
b) If positioning the antenna inside the
chamber, be careful of the SMA cable
2. Align the antenna with the length of the

Figure 6 Test Antenna Setup

chamber
3. Use the bubble level to verify the polarization
II. Mount the AUT
A. Remove the window at end ‘B’ of the chamber
1. Do not put it on the floor
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B. Remove the clear acrylic mount from the AUT
positioner fixture
1. It is safe to gently rotate the positioner
manually
C. Bolt the antenna by its adaptor to the acrylic
flange
1. Use washers to protect the surfaces
2. For small, lightweight antennas, use masking
Figure 7 AUT Mount

tape instead of bolts
D. Replace the acrylic mount with AUT in the positioner fixture
1. Be careful not to scrape the foam
E. Connect the port 1 SMA cable to the AUT
1. The SMA cable should feed up through the
middle and out the side of the clear acrylic
mast, then through one of the smaller holes
in the horizontal arm of the black plastic
fixture to the AUT.
a) Do not feed the SMA cable through the
clear acrylic mount, as it will interfere with

Figure 8 AUT in Chamber

the foam during rotation.
2. Use an N to SMA female adaptor as needed
3. Do not over tighten
F. Point the AUT in the general direction of the receive antenna
1. Use the bubble level to verify the polarization
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III. Connect the VNA and Positioner to the PC and
power them on
A. The positioner power is controlled by a surge
protector on the desk
B. Port 1 should be connected to the AUT
C. Port 2 should be connected to the receive
antenna
D. The VNA uses a GPIB to USB cable

Figure 9 Positioner Power Switch

E. The Positioner uses an RS-232 to USB cable
F. Wait for the VNA to complete its self-test
G. If the VNA is already on, reset it to the default configuration
IV. Start the program
A. Download and unzip the Quick Start folder to the desktop
1. Keep AMS.exe and the Matlab Scripts folder in the same directory
B. Run AMS.exe
1. A Matlab command window will open. Do not close it.
C. Click the run arrow in the toolbar and wait for the status window to display Ready
1. The program will now detect and initialize the VNA and positioner
2. The program will also automatically link to the Matlab Scripts folder
D. Select a folder to store your measurements using the Results Folder control on
the left-hand column.

If any errors occur after executing the program, check that the VNA and
positioner are connected to the computer and powered on, then click the run arrow. If the
problem persists, close AMS.exe, reopen it, and try again.
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Calibration

Figure 10 LabVIEW Front Panel: Calibration

There are two calibration types. Perform a Reflection Only calibration (faster) to
just measure S11. Perform a Full 12-Term calibration to measure S11, S21, and radiation
pattern. In the interest of time over accuracy, the user can skip calibration if only
measuring S21 or radiation pattern, but should then normalize the data to zero. A UI
button to normalize data is on the Radiation Pattern tab. Also, note the following:

•

The system defaults to 1601 points.

•

The user must manually calibrate the HP network analyzers.

•

When measuring calibration standards, tape the ends of the SMA cables to
somewhere convenient to make attaching the standards easier. Do not use
tape on the foam.
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Reflection Only Calibration
I.

Set calibration parameters
A. Set the Start Frequency and Stop Frequency
B. Set the Standard Calibration Type to Reflection Only Forward
C. Select the Connector Type
D. Select the Connector Gender

II. Perform the calibration
A. Click the Run Calibration button
1. LabVIEW will now program the VNA
2. Wait for a prompt that says “Measure Device”
B. Measure the calibration standards
1. Read the VNA screen to see what device to connect
2. For each calibration standard, connect it to the cable and click OK in the
Measure Device prompt, then wait for the measurement to finish.
3. The VNA will beep after completing each device
4. Table 1 shows the calibration sequence
Table 1 Reflection Only Calibration Sequence
Step Port 1
1 Open
2 Short
3 Broadband Load

III. Reconnect the cable to the antenna to be measured
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Full 12-Term Calibration
I.

Position the AUT at boresight
A. Go to the Positioner Controller tab
B. If the AUT does not have a distinct main beam, it must be positioned manually
1. Gently position the AUT by hand
2. Alternatively, use the quick step buttons
a) Use New Angle, CW Step, and CCW Step. to locate the AUT
b) Do not go beyond ± 360º, as this could damage the SMA cable
c) Click Set This Position to Zero
3. Skip to step II
C. If the AUT does have a distinct main beam, the program can position it
automatically
1. Set Freq above the Auto Locate Boresight Position button to your
frequency of interest
2. Click the Auto Locate Boresight Position button
a) The Precision controls the increment the program will use when auto
locating
b) This can be done with window ‘B’ open.
3. Wait for the Current Angle indicator to display 0
D. Verify the AUT is at boresight
1. Look through the window on side ‘A’ of the chamber with a flashlight
2. If the AUT is off boresight, use the CW Step and CCW Step buttons to
manually align it, and click Auto Locate Boresight Position again.
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3. If that does not work, use the quick step buttons to position the AUT
manually. See step B.
II. Set calibration parameters
A. Set the Start Frequency and Stop Frequency
B. Set the Standard Calibration Type to Full 12-Term
C. Select the Connector Type
D. Select the Connector Gender
III. Perform the calibration
A. Click the Run Calibration button
1. LabVIEW will now program the VNA
2. Wait for a prompt that says “Measure Device”
B. Measure the calibration standards
1. Read the VNA screen to see what devices to connect
2. For each calibration standard, connect it to the cable and click OK in the
Measure Device prompt, then wait for the measurement to finish.
3. The VNA will beep after completing each device
4. Table 2 shows the calibration sequence
Table 2 Full 12-Term Calibration Sequence
Step Port 1

Port 2

1 Broadband Load

Broadband Load

2 Open

Short

3 Short

Open

4 Through Line

Through Line
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Taking Measurements
After taking measurements, the program automatically builds a descriptive file
name and saves the data to a tab delimited text file with headers in the Results Folder.
The file name is displayed below the plots. Note that if the same measurement is
performed twice, previous data will be overwritten.

Figure 11 The Microwave Lab Anechoic Chamber
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S-Parameters

Figure 12 LabVIEW Front Panel: Uncalibrated S21 Measurement

IV. Close the chamber windows
V. Go to the S-Parameters tab
VI. Select desired S-Parameter
VII. If measuring S21 or S12, enter the Polarization configuration
VIII.Enter the Start Frequency and Stop Frequency
IX. Click the Take Measurement button
A. After a few seconds, Log Magnitude and Phase data will display on the plots.
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Radiation Pattern

Figure 13 LabVIEW Front Panel: Uncalibrated Radiation Pattern Measurement
I.

Close the chamber windows

II. Go to the Radiation Pattern tab
III. Select the desired S-Parameter
IV. Select a CW Frequency
V. Set the Span and Step Size
A. The program uses Span to determine the start and stop angles, but 0º is always
the center angle.
VI. Enter the Polarization configuration
VII. If you skipped the calibration step, switch Normalize to ON
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A. Normalize simply tells Matlab to plot the polar radiation pattern such that the
maximum log magnitude is scaled to 0 dB. This scaling is only temporary and
does not affect the data that gets saved.
VIII.Click Run Rad Pattern Test
A. The positioner will first rotate the AUT to -Span/2, then step through to +Span/2,
plotting each data point as it is measured.
B. To cancel a sweep, click the Cancel Sweep button
C. After the last measurement
1. The positioner returns to 0º
2. The tabular data gets saved to a text file
3. Matlab plots the logarithmic polar radiation pattern
a) Note you must manually save the figure as a .png
4. Matlab calculates the HPBW, and estimates the Directivity
a) Note these values are not saved

Figure 14 Matlab Pattern Plot Comparison of the Narda 643 Antenna
(ML = Microwave Lab) (CL = Hangar Lab)
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APPENDIX F: RadPatternPlot.m
function [ ] = RadPatternPlot( file, line_style, normalize )
% Rad_Patt.m calls dirplot.m to plot the radiation pattern of an
% antenna from a data file recorded with the Cal Poly LabVIEW
% Antenna Measurement System (AMS) in the Microwave Lab (Bld 20,
% Rm 116).
%
%
file
= String containing the path to the text file to
%
be plotted.
%
line_style = String specifying line style with normal Matlab
%
syntax.
%
See plot for more help.
%
normalize = Boolean value. True plots pattern normalized
%
such that the
%
maximum dB is 0. False plots the original data.
%
% Dylan Bloom
% bloomdylan@gmail.com
% Revised 5/30/15
%% Import Data
A = importdata(file, '\t', 1);
phi = A.data(:,1);
mag = A.data(:,2);

% Import data from text file
% Take the 1st column to be angles
% Take the 2nd column to be magnitudes

%% Normalize magnitudes so that maximum is 0dB
if(normalize)
mag = mag - max(mag);
% max(mag) is a negative number
end
%% Plot radiation pattern
%RHOMIN = floor((min(mag) - max(mag))/10)*10;
% Min magnitude rounded down to 10s place (note min mag is
% negative e.g. -47.5dB --> -50dB)
if(normalize)
RHOMAX = 0;
else
RHOMAX = 5;
end
RHOMIN = -40;
RHOTICK = (RHOMAX-RHOMIN)/5;
% Number of ticks so that ticks are
% every 5dB
parameters = [RHOMAX, RHOMIN, RHOTICK];
dirplot(phi, mag, line_style, parameters)
% See dirplot.m help for more info
title(strrep(file(1:end-4),'_',' '))
% Replace '_' in file name with
' '
xlabel(A.colheaders(1))
ylabel(A.colheaders(2))
end
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APPENDIX G: Directivity.m
function [ D, HPBW ] = Directivity( file, step_size )
% Directivity.m estimates the directivity of an antenna from its
% radiation pattern data, as recorded with the Cal Poly LabVIEW
% Antenna Measurement System (AMS) in the Microwave Lab (Bld 20,
% Rm 116).
%
% file - Name of data text file
% step_size - Step size in degrees
%
% D - Directivity
% HPBW - Half Power Bandwidth
%
% This vi assumes magnitude data goes from [0:step:360-step]
%
% Dylan Bloom
% bloomdylan@gmail.com
% Revised 5/30/15

%% Import Data
A = importdata(file, '\t', 1);
% Import data from text file
mag = A.data(:,2);
% Take the 2nd column to be magnitudes
%% Estimate -3dB points (Half Power points)
[maximum,max_index] = max(mag);
last = find(mag(max_index:end) < maximum-3.01, 1,'first') + ...
max_index - 1;
% mag(max_index:end) is a monotonically decreasing array
% starting at max and going cw.
% From that array, find the index of the first value that
% drops below the -3dB value. Re-add the max index, then
% subtract 1.
first = max_index + 1 - ...
find(flipud(mag(1:max_index)) < maximum-3.01, 1, ...
'first');
% flipud(mag(1:max_index)) is a monotonically decreasing
% array starting at max and going ccw.
% From that array, find the index of the first value that
% drops below the -3dB value. Subtract that index from
% the max_index.
%% Calculate Half Power Beam Width
HPBW = (last - first) * step_size;
HPBW_rad = HPBW * pi/180;

% difference = Half Power
% Beam Width
% Convert to radians

%% Calculate beam solid angle
beam_solid_angle = 2*pi*(1-cos(HPBW_rad/2));
%% Calculate Directivity D
D = 4*pi/beam_solid_angle;

% Formula
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% Formula

D = D/2;
if D > 100
D = NaN;
end end

% Take half because 2 antennas (value
% is in dB)
% If directivity doesn't make sense
% Return Not a Number
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APPENDIX H: HFSS 2.4 GHz Pyramidal Horn Tutorial
Read section 9.4.3 The Pyramidal Horn Antenna in Antenna Theory and Design
3rd ed., and use the design equations to design a 2.4 GHz pyramidal horn antenna. Use
the following figure from the book for reference.

Getting Started
I.

Launch ANSYS HFSS

II. Verify Tools Settings
A. Select the menu item Tools > Options > HFSS Options…
B. HFSS Options Window:
1. Duplicate boundaries/mesh operations with geometry: Checked
2. Click OK.
C. Select the menu item Tools > Options > Modeler Options…
D. Modeler Options Window:
1. Click the Drawing tab
a) Edit properties of new primitives: Checked
2. Click OK.
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III. Open a New Design
A. Select the menu item Project > Insert HFSS Design
IV. Set Solution Type
A. Select the menu item HFSS > Solution Type…
B. Solution Type: “Project Name - Design Name” Window:
1. Choose Driven Modal Network Analysis
2. Click OK
Creating the 3D Model
I.

Set Model Units
A. Select the menu item Modeler > Units…
1. Set Model Units Window:
a) Select units: cm
b) Click OK

II. Set Default Material
A. From the drawing toolbar drop down menu, choose vacuum
III. Set Drawing Plane
A. From the drawing toolbar drop down menu, change XY to YZ
IV. Create the Rectangular Waveguide
A. Select the menu item Draw > Box
B. Draw an arbitrary box and a properties window will appear
C. Properties Window:
1. Position: 0, -waveguide_width/2, -waveguide_height/2
2. Add Variable Window:
a) Enter design values for each parameter followed by “cm”
b) waveguide_width = a from book
c) waveguide_height = b from book
3. XSize: waveguide_length
4. Add Variable Window:
a) waveguide_length = 7 cm
5. YSize: waveguide_width
6. ZSize: waveguide_height
7. Click OK
D. Set the Object Name
1. From the Properties toolbox on the left, set the name to Waveguide
E. Fit the View
1. Press CTRL+D
F. From the Properties toolbox click the Transparent Value
1. Set Transparency Dialog:
a) Set Transparency to 0.5
b) Click OK
V. Create the Horn Base
A. Select the menu item Draw > Rectangle
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B. Draw an arbitrary rectangle
C. Properties Window:
1. Position: waveguide_length, -waveguide_width/2, -waveguide_height/2
2. YSize: waveguide_width
3. ZSize: waveguide_height
4. Click OK
D. Set the Object Name
1. From the Properties toolbox on the left, set the name to Horn_Base
VI. Create the Horn Top
A. Select the menu item Draw > Rectangle
B. Draw an arbitrary rectangle
C. Properties Window:
1. Position: horn_length+waveguide_length, -aperture_width/2, aperture_height/2
2. Add Variable Window:
a) Enter design values for each parameter followed by “cm”
b) horn_length = RP from book
c) aperture_width = A from book
d) aperture_height = B from book
3. YSize: aperture_width
4. ZSize: aperture_height
5. Click OK
D. Set the Object Name
1. From the Properties toolbox on the left, set the name to Horn_Top
E. Fit the View
1. Press CTRL+D
VII. Connect the Objects
A. Select the Horn_Base and Horn_Top from the Modeler design tree.
B. Select the menu item Modeler > Surface > Connect
C. Name the object Horn
VIII.Complete the Antenna
A. Select all objects
1. Press CTRL+A
B. Select the menu option Modeler > Boolean > Unite
IX. Create an Air Box around the Horn Antenna
A. Select the menu item Draw > Box
B. Draw an arbitrary box and a properties window will appear
C. Properties Window:
1. Position: 0, -aperture_width*1.1/2, -aperture_height*1.1/2
2. XSize: (horn_length+waveguide_length)*1.05
3. YSize: aperture_width*1.1
4. ZSize: aperture_height*1.1
5. Click OK
D. Set the Object Name
1. From the Properties toolbox on the left, set the name to Air
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E. Fit the View
1. Press CTRL+D
F. From the Properties toolbox click the Transparent Value
1. Set Transparency Dialog:
a) Set Transparency to 0.9
b) Click OK
Assigning Boundaries and Excitations
I.

Create the Wave Port
A. Select the menu item Edit > Select > Faces
B. Select the menu item Edit > Select > By Name…
C. Select Face Dialog:
1. Choose the back face of the Waveguide
2. Click OK
D. Select the menu item HFSS > Excitations > Assign > Wave Port…
E. Wave Port Window:
1. Name: 1
2. Click Next
3. Click Next
4. Click Finish

II. Assign a Radiation Boundary
A. Select the menu item Edit > Select > Objects
B. Select the menu item Edit > Select > By Name…
C. Select Object Dialog:
1. Choose the Air
2. Click OK
D. Select the menu item HFSS > Boundaries > Assign > Radiation…
E. Radiation Boundary Window:
1. Name: Rad1
2. Click OK
III. Assign the Antenna a Perfect Electric Field Boundary
A. Select the menu item Edit > Select > Faces
B. Select the menu item Edit > Select > By Name…
C. Select Face Dialog:
1. Select all faces of the Horn except the aperture
2. Click OK
D. Select the menu item HFSS > Boundaries > Assign > Perfect E…
E. Perfect E Boundary Window:
1. Name: Horn_Walls
2. Click OK
Setting up the Analysis
I.

Create an Analysis Setup
A. Select the menu item HFSS > Analysis Setup > Add Solution Setup…
B. Driven Solution Setup Window:
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1. Name: Setup1
2. Solution Frequency: 2.4 GHz
3. Maximum Number of Passes: 20
4. Maximum Delta S: 0.02
5. Click OK
C. Select the menu item HFSS > Analysis Setup > Add Sweep…
D. Select Setup1
E. Edit Frequency Sweep Window:
1. Sweep Name: Sweep
2. Sweep Type: Fast
3. Type: LinearCount
4. Start: 1 GHz
5. Stop: 6 GHz
6. Count: 1601
7. Click OK
II. Validate the Model
A. Select the menu item HFSS > Validation Check…
B. There should only one warning about the Perf E boundary overlapping the
Radiation Boundary. This can be ignored.
Analyzing and Creating Reports
I.

Analyze the Model
A. Select the menu item HFSS > Analyze All

II. Create an S11 Plot
A. Select the menu item HFSS > Results > Create Modal Solution Data Report >
Rectangular Plot
B. Report Window:
1. Click New Report
2. Click Close
III. Create a Far Field Setup
A. Select the menu item HFSS > Radiation > Insert Far Field Setup > Infinite
Sphere…
B. Far Field Radiation Sphere Setup Window:
1. Name: Infinite Sphere1
2. Phi Start: -180
3. Phi Stop: 180
4. Phi Step Size: 1
5. Theta Start: 0
6. Theta Stop: 180
7. Theta Step Size: 10
8. Click OK
IV. Create a Far Field 3D Polar Plot
A. Select the menu item HFSS > Results > Create Far Fields Report > 3D Polar
Plot
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B. Report Window:
1. Mag: dB(rETotal)
2. Click New Report
3. Click Close
V. Overlay the 3D radiation pattern on the model
A. Double click on the design in the project tree
B. Select the menu item HFSS > Fields > Plot Fields > Radiation Field…
C. Overlay Radiation Field Window:
1. Visible: Checked
2. Transparency: 0.5
3. Scale: 1.0
4. Click Apply
5. Click Close
6. Press CTRL+D
VI. Create a Far Field Rectangular Plot
A. Select the menu item HFSS > Results > Create Far Fields Report >
Rectangular Plot
B. Report Window:
1. Primary Sweep: Phi
2. Mag: dB(rETotal)
3. Click New Report
4. Click Close
Exporting Data from HFSS
I.

Export Rectangular Field Plot Data
A. Select the Rectangular Field Plot under Results in the project tree
B. Select the menu item Report2D > Export…
C. Export Report Dialog:
1. Click Browse
2. File Name: HFSS Rectangular Field Plot

II. Modify the file for Matlab
A. Open the .txt file in Excel
B. Delete all columns except for Phi [deg] and Theta=’90deg’
C. Delete rows 1-5 and 7
D. Press CTRL+S
III. Export Rectangular S11 Plot Data
A. Repeat steps I and II above (except II B) for the Rectangular S11 Plot
B. File Name: HFSS S11 Plot
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